FabFilter Twin 2
User Manual
# Table of Contents

## Introduction
- About FabFilter Twin 2 .................................................. 3
- Quick start ........................................................................ 5

## Using FabFilter Twin 2
- Overview ........................................................................... 6
- What-you-use-is-what-you-see ........................................... 8
- Knobs ............................................................................... 10
- Component buttons .......................................................... 11
- Oscillators ....................................................................... 12
- Filters ............................................................................... 14
- Interactive filter display .................................................... 16
- Delay section .................................................................... 17
- Modulation ........................................................................ 19
- Drag-and-drop modulation slots ....................................... 20
- XLFO ............................................................................... 21
- Envelope generator ........................................................... 23
- Envelope follower ............................................................. 25
- MIDI source ..................................................................... 26
- XY Controller ................................................................... 27
- Polyphony and unison ......................................................... 28
- Output controls ................................................................. 29
- MIDI Learn ....................................................................... 30
- Undo, redo, A/B switch ....................................................... 31
- Tips & tricks ...................................................................... 32
- Stand-alone (Windows) ....................................................... 33

## Presets
- Loading presets .................................................................. 34
- Saving presets .................................................................... 35
- Section presets ................................................................... 36
- How presets are stored ....................................................... 37

## Purchasing FabFilter Twin 2
- Purchasing FabFilter Twin 2 .............................................. 38
- Entering your license key ..................................................... 39

## Support
- Support ............................................................................ 40
- Upgrading to Twin 2 ........................................................ 41
- Manual installation ............................................................. 42
- Using the side chain .......................................................... 43
- MIDI CC table .................................................................. 45
- License agreement ............................................................. 46
- Acknowledgements ........................................................... 48
- About FabFilter ............................................................... 49
About FabFilter Twin 2

Tons of new features...

Of course, this new version of the Twin software synthesizer brings a lot of new features. To start with, you now get three full-featured oscillators instead of two. Then, we have added a delay effect section with two delay lines and two filters, which you can use to create all sorts of delay, echo, chorus, flanger and phaser effects. And finally, Twin's award-winning filters now contain all 11 filter characteristics from Volcano 2!

But the main improvements are definitely in the modulation section. Twin's celebrated drag-and-drop modulation system now offers 50 modulation slots. And instead of the simple LFOs and EGs from Twin 1, you now get all the XLFOs, Envelope Generators, Envelope Followers, MIDI Sources and XY Controllers you need! Twin 2 also has a side-chain input, which feeds the Envelope Followers and can be used to trigger the Envelope Generators. There's also our improved MIDI Learn system, which makes it easy to connect your hardware controllers to Twin's parameters.

... and a brand new look!

One of the first things you'll notice, is Twin 2's brand new user interface. We have put a lot of effort into ensuring that Twin is still extremely easy to use, even with all its new features! We improved the top section by introducing Component Buttons: multi-purpose buttons that both show the state of a component (oscillator, filter or delay) and let you alter the values of its most important parameters using XY mouse movements. Together, the component buttons show you the internal routing of the synthesizer.

The bottom section of FabFilter Twin has the what-you-use-is-what-you-see modulation interface, introduced earlier in Volcano 2. The idea is simple yet powerful: Do you want an extra Envelope Generator? Just add one! Do you want an XY Controller? Just add one and start modulating things! At all times, the interface only contains modulation sources and slots that you are actually using. This results in an elegant user interface that experienced producers and novices alike will embrace. Finally, the traditional modulation slots from Twin 1 are replaced by a far more intuitive slot view per modulation source!

Modulation madness

Twin 2 brings new and improved modulation sources and because of our improved interface, you don't have to worry about how many sources you have: there are enough sources to keep you busy for a long time! Modulation connections are still extremely easy to make via drag-and-drop.

Our improved XLFO offers you anything from a simple sine wave to a fully programmable 16-step sequencer. The Envelope Generators and Envelope Followers can make use of the plug-in's side-chain signal, the XY Controllers are a great way to make your presets more fun to play with, and the new MIDI modulation sources let you modulate parameters using any form of MIDI data.

Finally

If you have spent some time with Twin 2, you will find use for it in any kind of project. The best way to discover what you can do with it is to explore the vast library of presets. Find out what a variety of effects you can create, and use them as a starting point for your own explorations.

FabFilter Twin 2 is available in VST, VST3, AU (Audio Units) and AAX Native formats (all both 64-bit and 32-bit).

<table>
<thead>
<tr>
<th>Windows requirements</th>
<th>macOS requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 10, 8, 7 or Vista</td>
<td>macOS 10.12 or higher (64-bit only)</td>
</tr>
<tr>
<td>64-bit or 32-bit</td>
<td>AU or VST 2/3 host or Pro Tools</td>
</tr>
<tr>
<td>VST 2/3 host or Pro Tools</td>
<td>Intel or Apple Silicon processor</td>
</tr>
</tbody>
</table>

Next: Quick start
See Also
Using FabFilter Twin 2
Upgrading to Twin 2
Quick start
The installer will copy the FabFilter Twin 2 plug-in into the common VST/VST3, AU (macOS only) and AAX plug-in folders on your computer. On macOS, the global plug-in folders in /Library/Audio/Plug-Ins are used.

In most cases, your host will then recognize the plug-in automatically. However, if the instructions below do not work, see Manual installation instead.

- **Cubase**
  Open the VST Instruments panel, click on an empty slot and select FabFilter Twin from the menu that appears. Right-click in the list of tracks and choose Add MIDI Track to create a new MIDI track and assign it to the new FabFilter Twin 2 instrument.

- **Logic**
  Create an Audio Instrument track in the arrange window and select FabFilter Twin 2 as the input and choose a preferred output. You will find FabFilter Twin 2 in the Audio Units -> FabFilter section (named FF Twin 2).

- **Ableton Live**
  In Session view, select the track you would like to place FabFilter Twin 2 on, for example by clicking the track name. At the left top of Ableton Live's interface, click on the Plug-in Device Browser icon (third icon from the top). From the plug-ins list, double-click FabFilter/FabFilter Twin 2, or drag it onto the track.

- **Pro Tools**
  Create a new stereo instrument track and add FabFilter Twin 2 as the first insert.

Use the Presets button at the top of the plug-in interface to try different settings from the many factory presets that are bundled with FabFilter Twin 2. Have fun!

Next: FabFilter Twin 2 overview

See Also
- Upgrading to Twin 2
- Overview
- Loading presets
Overview

FabFilter Twin 2's interface is divided into multiple sections:

- **Presets, undo and A/B**
  The Undo, Redo, A/B and Copy buttons at the top of the plug-in interface enable you to undo your changes and switch between different states of the plug-in. With the preset buttons, you can easily browse through the vast library of factory presets or save your own settings so you can re-use them in other songs.

- **Synth section**
  The top section is the actual synth, the sound-producing heart of the instrument. Here you'll find the oscillators, the filters, the main envelope generator and the delays logically displayed, together with general settings like portamento, master tune and volume controls. Each component of the synthesizer is represented by a component button that shows its state and lets you edit it directly.

- **Modulation button**
  The modulation button shows or hides the entire modulation section at the bottom of the interface. FabFilter Twin 2 offers virtually unlimited modulation possibilities, but all this power might be a bit intimidating. That's why the modulation section is hidden by default, and you can look 'under the hood' when you want to tweak a preset or design your own.

- **Source selection bar**
  The source selection bar shows all modulation sources at a glance and lets you easily scroll around and create new sources. FabFilter Twin 2 offers XLFO, Envelope Generator (EG), Envelope Follower (EF), MIDI and XY Controller sources. See also Modulation.

- **Modulation slots and sources**
  The bottom section contains the modulation overview. Twin 2 is a fully modular synthesizer without the cables! We found a simple way to show you everything that is modulating, and what is modulated by what. Above each modulation source, the modulation slots show exactly what targets are modulated by this source and let you adjust the amount of modulation. You can very easily set up modulation connections with drag-and-drop. All in all, we think we made sound design easier and more fun!

- **MIDI Learn, monitoring and output mix**
  The bottom bar contains the MIDI Learn feature which sets up any MIDI controller to control any plug-in parameter. Next, we find various polyphony and unison settings which give you the possibility to create super-fat sounds. At the far right are stereo spread and output level settings.

- **Resize**
  The resize button in the lower-right corner lets you choose between normal and wide interface layouts. The wide layout is designed such that the component display at the top half of the interface never needs to be scrolled. Most hosts support dynamic resizing of the interface; otherwise just close and re-open the interface window.

- **Presets**
With the preset buttons, you can easily browse through the factory presets or save your own sounds so you can re-use them in other songs. See also Presets.

Next: What-you-use-is-what-you-see
See Also
Quick start
What-you-use-is-what-you-see

Often an impressive feature list results in an impressively difficult-to-use interface full of controls for parameters you might never even use. For almost every plug-in developer one of the greatest challenges when making a complex full-featured plug-in is to design an interface that is easy to use. And we think we did it! FabFilter introduces a revolutionary new interface concept: What-you-use-is-what-you-see.

The idea is simple yet powerful. At all times, the interface only contains the modulation sources and slots that you are actually using. This results in an intuitive user interface that experienced producers and novices alike will embrace.

You can easily create more modulation sources. Do you want another XLFO? Just add one! Do you want an envelope generator? Just add one and start modulating things! Of course there is a limit to the number of sources you can create, but in practice it feels like you can create as many sources as you will ever need.

To give you an idea, a simple preset with the modulation section hidden looks like this:

![Simple preset](image1)

... and a more complex preset, with various modulation sources and modulation, looks like this:

![Complex preset](image2)

To help you understand even the most complex presets, modulation slots are grouped with each source. Each component, knob or controller that is being modulated is marked with a little M button. Simply click the M to highlight the modulation source and slots responsible for the modulation. See also Modulation.

Another interface innovation are the component buttons. These make it possible to do more in depth editing of parameters you don’t need to see all the time. Only when you want, the interface can show more parameters of the oscillators, filters or delays.

**Tip:** the resize button in the lower-right corner of the interface allows you to make the interface wider, so you can see more components and modulation sources at the same time.
Knobs

It is easy to control FabFilter Twin 2’s parameters with the large round knobs. They will light up when you move the mouse cursor around to indicate that you can adjust them. The moment you move the mouse cursor over a knob, a parameter value display will pop up, which shows the name and the current value of the parameter.

All knobs support four ways of control:

1. **Vertical mode**
   Click on the center area of a knob and drag up or down to rotate it. The knob reacts to the speed with which you are dragging, so if you move the mouse slowly, you make precise adjustments.

2. **Rotate mode**
   Grab the arrow of the knob and drag it around. By moving the mouse cursor further away from the knob while dragging it, you can make precise adjustments.

3. **Mouse wheel mode**
   Perhaps the easiest way to make adjustments is by using the mouse wheel when you hover over a knob. This mode works for all the knobs and possible panning rings. (On Windows, you might need to click in the plug-in interface first to make sure it is the active window.)

4. **Text entry mode**
   Double-click a knob to enter an exact value using the keyboard.

Tips

- **To reset** a knob to its default position, hold down the `Ctrl` key (Windows) or `Command` key (macOS) and click the knob once. Note: In Pro Tools, Twin 2 uses the default Pro Tools keyboard shortcut for reset: `Alt`+click.

- **To fine-tune** a value when using vertical drag mode or the mouse wheel, hold down the `Shift` key while dragging or moving the mouse wheel. Note: In Pro Tools, Twin 2 uses the default Pro Tools keyboard shortcut for fine tune: `Ctrl`+drag on Windows or `Command`+drag on macOS.

- There are several **handy shortcuts in text entry mode**. With frequency values, you can type e.g. ‘1k’ to set the value to 1000 Hz, and also ‘A4’ for 440 Hz, or even strings like ‘C#3+13’. With dB values, you can type e.g. ‘2x’ to get +6 dB (the value that corresponds to two times louder). With all values, you can also type a percentage (e.g. ‘50%’ will put a knob exactly in the middle position).

- Sometimes, knobs in our plug-in interfaces are **linked**: these be adjusted simultaneously by holding down the `Alt` key (`Shift` key in Pro Tools) while dragging on one of them. For example, an output level and input level setting of a plug-in could be adjusted simultaneously (in the opposite direction) this way.

Next: **Component buttons**

See Also

**Support**
Component buttons

All components that make up the synthesizer in FabFilter Twin are displayed as large component buttons in the top section of the interface: three oscillators and following the signal path, two filters, two delays, and two more filters in the delay section.

You can edit the most important parameters of a component directly by clicking and dragging on the component button. As soon as you move the mouse cursor over a component button, value displays will pop up to show the current values of those parameters.

- Drag horizontally and vertically to change the parameters. There are two sets of parameters: you can toggle between them by holding down the Ctrl key on Windows, or the Command key on macOS. For example, in the above screen shot, you would normally change the filter frequency and peak parameters; by holding down Ctrl/Command, you adjust the filter panning and response curve parameters instead.
- To view all parameters of a component, such as a filter or oscillator, click the component button once. This will expand the complete interface for all related components. Click the component button again to hide the interface. While a component interface is expanded, you can scroll the top section of Twin's interface with the left and right scroll buttons at the far ends of the interface.
- Hold down Shift while dragging to adjust only one parameter in the direction in which you move the mouse cursor.
- Hold down Alt while dragging to adjust all related components in parallel.
- You can also adjust the component buttons with the mouse wheel. On Windows, most mouse wheels only work vertically, but you can hold down the Ctrl and Shift keys simultaneously for horizontal adjustments.
- Each of the buttons has an on/off switch in the left top corner, to quickly enable or disable the component.

We strongly suggest for you to try all these movements yourself, and you'll find it's a great aid in quickly setting up Twin the way you like. The most important parameters are always available, and if you need access to all parameters, they are just a mouse click away.

Tips

- Clicking the Main EG button does not open a dedicated EG section, but rather highlights the Main EG source in the modulation section.
- You can turn off the parameter value displays for the component buttons with the Show Component Displays option in the Help menu.
- The resize button in the lower-right corner of the interface allows you to make the interface wider, so you can see more components at the same time.

Next: Oscillators

See Also
Knobs
Support
Oscillators

FabFilter Twin 2 comes with three full featured oscillators. Combined with our award winning filters this gives you an exceptional broad palette of sounds. The oscillators are very analog sounding and completely aliasing-free (for the digifoobs!). For every oscillator the following parameters are available:

- **Enabled**
  This will turn an oscillator on or off, so you can easily check the contribution of an oscillator to the overall sound, or turn it off to reduce CPU usage.

- **Scale**
  Each oscillator can be transposed up to 3 octaves above the master tune.

- **Waveform**
  The Waveform parameter selects the waveform that the oscillator produces:
  1. Triangle (a soft, warm tone)
  2. Sawtooth (a sharp bright tone that is ideal for filtering)
  3. Square (a more metallic sound, adjustable with the pulse width setting)
  4. Sine (a simple sine wave, the most basic waveform without overtones)
  5. White noise (has a flat frequency response, meaning all frequencies at equal power)
  6. Pink noise (is like white noise but with less power in the higher frequencies)

- **Phase Sync**
  Next to the waveform setting, the Phase Sync button (with a MIDI icon) toggles oscillator phase sync on and off. When oscillator phase sync is on, the oscillator resets its phase to halfway the waveform on each note-on event. With short, percussive sounds, this works really well to create a sharp and aggressive attack with every note. However, normally you should turn it off because it sometimes introduces unwanted clicks.

- **Detune**
  The Detune knob sets the detune for each oscillator. The detune knob has a range of +/- one octave, and is extra sensitive around the 0 position. It is a modulation target as well. Like any other knob, you can double-click it to enter a value directly using the keyboard. For example, try ‘0.5 octaves’ or ‘1 semitone’ or ‘50 cents’. See Knobs for more information.

- **Pulse Width**
  The Pulse Width knob adjusts the pulse width of the square waveform, from an even square to an infinitely thin pulse (which is actually inaudible). The pulse width is a modulation target and is only available when a square wave is selected.

- **Sync**
  The Sync knob adjusts the level of hard sync for its oscillator. When set to 1, the oscillator works normally without hard sync. When set to a higher value, the oscillator will ‘squeeze’ more phases into one actual audible phase, which drastically changes the harmonics in the sound with a metallic-sounding effect. Sync is a modulation target.

- **Level/Pan**
  The volume and pan of each oscillator can be adjusted using the combined Level/Pan knobs. The inner knob set the overall level and outer ring sets the panning. Both are modulation targets.

- **Ring modulation**
  You can ring modulate the first oscillator with the second oscillator using the small * button.
between the component buttons for oscillator 1 and 2. Ring modulation combines two waveforms, and outputs the sum and difference of the frequencies present in each waveform. This produces a signal rich in overtones, suitable for producing bell-like or otherwise metallic sounds.

- **Master Tune/Scale**
  The Master Tune knob determines the global frequency offset of all oscillators. The menu above the knob transposes the frequency by full octaves. The Master Tune knob is a modulation target so you can modulate the frequency of all oscillators at once.

- **Portamento**
  The Portamento knob adjusts the amount of portamento or glide, which makes the oscillators slide from one note to another. A little portamento is great for smooth keyboard solos, or when playing large bass intervals. Good portamento is one of those things that give your play just that little bit extra: it's magic. So we have fine-tuned it until it was just perfect! The best thing is: we have created a unique portamento because it also works in polyphonic mode, so you can play sliding chords. You can choose between two different portamento modes.
    1. When using Normal portamento (high/low key portamento), gliding will happen always when holding down keys.
    2. When using Legato portamento (also called fingered portamento), gliding will not be applied for the first key pressed, only for the keys after that.

Portamento is also a modulation target.

**Tips**
- Disabling an oscillator reduces CPU usage. Also, the oscillators operate more efficiently when the Sync knob is set to 1 and is not modulated (disabling hard sync).
- When you want to change any oscillator parameter for all oscillators at the same time, just hold down the *Alt* key while turning a knob.
- The *section presets* button next to the level/pan knobs for the oscillators lets you store and retrieve all oscillator parameters as a section preset, which is very useful for accessing often-used combinations of parameters.

**Oscillator component buttons**

Each oscillator is visually represented as a *component button*. By clicking on the component button and dragging, you can directly alter the most important oscillator parameters:

- **Detune**: drag horizontally
- **Scale**: drag vertically
- **Sync**: drag horizontally while holding down the *Ctrl* (Windows) or *Command* (macOS) key
- **Wave Form**: drag vertically while holding down the *Ctrl* (Windows) or *Command* (macOS) key

Click on a button to open the full oscillator interface (shown in the screen shot above) that provides access to all parameters. For other component shortcuts, see *Component buttons*.

*Next*: Filters

*See Also*

*Overview*
Filters

FabFilter Twin 2 has four multi-mode stereo filters. The two main filters are put right after the oscillators and the other two are used within the delay section. The filters can be routed in three modes: serial, parallel and per oscillator/delay. Every filter can be switched between low-pass, high-pass, and band-pass responses with 12, 24 and 48 dB/octave slopes and a staggering amount of eleven different high-quality filter characteristics that define the unique sound and overdrive of the filter. They range from smooth with moderate overdrive to raw, self-oscillating and over-the-top! All characteristics have been tuned very carefully, using our state-of-the-art FabFilter filter technology.

For every filter the following parameters are available:

- **Frequency**
  The filter frequency is adjustable over the entire audio range. The Frequency controls the center or cut-off frequency of the filter and can be controlled in real time, either manually, via modulation, or via external devices using MIDI.

- **Pan**
  The Pan ring around the Frequency knob lets you filter the left and right channels differently. It works as a stereo balance setting for the center frequency of the filter. For example, when you turn the Pan knob to the left, the left channel will be filtered with a lower center frequency, and the right channel will be filtered with a higher center frequency. You can use this to create various stereo filtering effects and thus it makes for a great modulation target.

- **Peak**
  The Peak knob adjusts the resonance of the filter. A little resonance will cause the filter to create warmer and more characteristic tones. At maximum resonance, the filter will self-oscillate with most filter characteristics.

- **Characteristic**
  FabFilter Twin 2 lets you choose between 11 different filter characteristics:
  1. FabFilter One, the original filter characteristic taken from our award-winning FabFilter One synthesizer
  2. Smooth, like the cream in your coffee
  3. Raw, a filter with lots of overdrive and exhibits a character of its own
  4. Hard, moderately distorting filter, with a nice clean whistle
  5. Hollow, juicy moderate distortion with fairly much low-end self-oscillation
  6. Extreme, for more wild sonic ideas
  7. Gentle, a more smooth and clean general purpose characteristic
  8. Tube, with a warmer sound and nice overdrive, great for synth sounds
  9. Metal, with a rough, sharper sound and distortion
  10. Easy Going, a softer version of the Tube filter
  11. Clean, linear behavior with no clipping or distortion at all

- **Response**
  The response of each filter can be set to either Low Pass, High Pass, or Band Pass. In Low Pass mode, the filter will pass through frequencies lower than the center frequency. In High Pass mode,
frequencies higher than the center frequency will be passed through. In Band Pass mode, only the frequencies around the cut-off frequency will be passed through.

- **Slope**
  The slope sets the steepness of the filter, which controls how aggressively the frequencies around the center frequency are filtered. You can choose between 12 dB/octave, 24 dB/octave or 48 dB/octave settings. For example, if the response is set to Low Pass, more high frequencies will be passed above the cutoff frequency using at 12 dB/octave than at 48 dB/octave. But let your ears decide! Just listen to the sound as you move the filter around and see if you like it...

- **Routing**
  The routing of the filters can be changed. The different settings are clearly graphically represented in the interface. There are three different setups:

  1. **Serial:** the sound passes through both filters serially. So the sound of all oscillators are led through filter 1 and then through filter 2.
  2. **Parallel:** the sound is led through both filters in parallel and the result is then mixed together after the filters.
  3. **Per Osc / Delay:** the output of oscillator 1 or delay 1 goes through filter 1, the output of oscillator 2 or delay 2 goes through filter 2. For the main filters, the output of oscillator 3 is routed through both filters.

  **Tip:** The section presets button next to the routing button lets you store and retrieve all filter parameters as a section preset, which is very useful for accessing often-used combinations of parameters.

### Filter component buttons

Each filter is visually represented as a component button. By clicking on the component button and dragging, you can directly alter the most important filter parameters:

- **Frequency:** drag horizontally
- **Peak:** drag vertically
- **Pan:** drag horizontally while holding down the Ctrl (Windows) or Command (macOS) key
- **Response:** drag vertically while holding down the Ctrl (Windows) or Command (macOS) key

Click on a button to open the full filter interface (shown in the screen shot above) that provides access to all parameters. For other component shortcuts, see Component buttons.

---

**Next:** Interactive filter display

**See Also**
- Oscillators
- Modulation
- Overview
Interactive filter display

The interactive filter display gives an overview of the filter parameters and makes it very easy to adjust multiple filter parameters simultaneously. The vertical lines in the background represent a logarithmic scale that correspond to the actual filter frequencies.

To open the filter display, click on one of the filter component buttons.

- Drag a filter dot to adjust the Frequency and Peak parameters for that filter.
- Drag the link dot between filter 1 and 2 to adjust both filters simultaneously.
- Shift+click a filter dot to toggle between the different filter slopes.
- Ctrl+click (Command+click on Mac) a filter dot to toggle between the different filter responses.
- When holding down the Alt key while dragging a filter dot, the other filter will change accordingly, as if you where dragging the link dot.
- Holding down both the Alt+Ctrl keys (Alt+Command keys on Mac) while dragging a filter dot will adjust the two filters while fixing the link dot in the center, so the other filter will 'mirror' the changes.

Tips

- Of course, all changes made in the filter display can be automated!
- You can connect a MIDI controller to either the frequency or the peak adjustment of the link dot with the MIDI Learn feature.

Next: Delay section

See Also
Filters
Overview
Delay section

FabFilter Twin 2 comes with an very useful delay section with two filters. The delay section makes all kinds of flanging and chorus effects possible, as well as typical delay effects, to give your sounds more stereo depth and rhytmical subtleties. Delay can be a very important aspect of sound design and the ability to modulate all the parameters will generate innovative and new sounds. The delay section consists of two separate delay lines and two multimode filters.

The following delay parameters are available:

- **Delay Time/Offset**
  The Delay Time parameter sets the delay time given to a signal passing through. The time display just above/below the Delay Time knob shows the current delay time in milliseconds.
  
  If Delay Sync is set a different value than Free or Ultra Short, this knob changes into the Delay Offset parameter, which sets a time offset relative to the synchronized delay time. More on this below.

- **Delay Sync**
  There are different ways to set the delay time. These different modes are set by the Delay Sync parameter next to the time display.

  The delay time can be locked/synchronized to the tempo of your sequencer host. When this is activated the delay time knob controls the sub-multiples of this tempo. The small dots that appear around the knob make it easier to get precise and quick access to those values that are related to your sequencer tempo like triplets and dotted notes.

  Or you can use the delay in a 'free mode'. Now the delay time is not synchronized to the host tempo and you can use the knob to set the delay time at any desired time. In this mode it is possible to 'tap' the tempo of the delay by clicking on the number-display next to the delay time knob. The display will turn into a purple TAP button. The next time you click here the time between the clicks is calculated and used as delay time. Just tap it a few times to get some values you want to work with.

  The 'Ultra Short' mode is designed to get the typical flanging, chorus and comb-filter effects. Now delay time can be precisely set between 0.1 and 50 milliseconds and feedback controls are disabled. Read the tips for more details on this.

- **Feedback, Cross Feedback**
  You can vary the feedback to produce more than one repeat from a single sound. All the feedback control does is send some of the delayed output (after passing through the filters) back to the input so it gets delayed again: the more feedback, the more repeats. There are separate knobs for the left and right filter output for both delay lines.

  When a signal coming out of a delay line is routed back into the other delay line this is called 'cross-feedback' hence the knob on the interface. Cross-feedback is used to mix different delay times and can create beautiful stereo effects.

  The amount of total feedback determines the number of audible repeats. Higher levels will have more repeats and above a certain level feedback will cause higher volumes at every cycle and thus create sonic mayhem! Be careful with your ears and speakers, and don't use too high feedback levels.

- **Link**
  When the little lock button between the two delays is activated, the controls for the first delay will
also control all parameters of the second delay. Therefore the controls of the second delay are disabled.

**Dry, Wet**
The large dry and wet level/pan knobs let you control the amount of dry (undelayed) and wet (delayed) signal that comes out of the plug-in. They are both modulation targets, but you must be aware that these are global volume settings, applied after all voices have been mixed together. Modulating this with source that is voice-dependent, such as MIDI velocity or an envelope generator, will not give good results. Instead, modulate the output level found in the bottom bar of the interface, because this level is applied for each voice separately, before they are mixed together.

**Enabled**
Each delay has a separate on/off switch. But we made another option available: the whole delay section can be turned on and off using the general buttons in the right bottom corner. 'I' means the delay is working and audible. 'O' means delay is turned off. Then there is one more option that always turns the delay section off regardless what the preset dictates. This setting cannot be saved in a preset and therefore will not be altered when browsing presets. This makes it possible to browse presets with the delay section permanently turned off. Don't forget to listen to the delay settings used in those presets. It sometimes is an important part of the sound design and can give great depth and groove to a sound.

**Tips**
- While holding down the Alt key you can adjust both delay parameters simultaneously. This works for all three knobs. This way it is easier to set up both delay lines with the same settings. For this to work with Delay time though, both delays must be set to work in the same sync mode.
- When holding the Alt key while dragging either the dry or wet level knob, both knobs will turn, but in the opposite direction. This is an easy way to control the mix of the wet and dry output while maintaining the same overall output level.
- By setting a delay time of between 30 and 100ms and adding a little gentle modulation with no feedback, you get the classic chorus effect.
- At very short delay times, (10 to 50ms in Ultra Short mode) increasing feedback will give a resonant cardboard tube or tunnel echo sound, the pitch of the resonance being set by the delay time. This effect is useful in creating new sounds or modifying existing ones beyond recognition it can create the illusion of ring modulation or phase sync.
- Short delays of between 30 and 100ms are used to create slap-back echo effects.
- Delay times in excess of 100ms, will give you the familiar tape echo type of sound, and this creates more rhythmic effects.
- If you are interested you can read more about delay technology on Wikipedia.
- The section presets button next to the delay filter routing button lets you store and retrieve all delay and delay filter parameters as a section preset, which is very useful for accessing often-used combinations of parameters.

**Delay component buttons**
Each filter is visually represented as a component button. By clicking on the component button and dragging, you can directly alter the most important filter parameters:

- **Time/Offset**: drag horizontally
- **Feedback**: drag vertically
- **Sync**: drag horizontally while holding down the Ctrl (Windows) or Command (macOS) key
- **Cross Feedback**: drag vertically while holding down the Ctrl (Windows) or Command (macOS) key

Click on a button to open the full filter interface (shown in the screen shot above) that provides access to all parameters. For other component shortcuts, see Component buttons.

**Filters**
Two filters are put after the delay lines in the signal path. The two filters are the same multimode filters as the main filters used after the oscillators. See Filters.
Modulation

Modular sound design employs modules as the basis of design. The modules in FabFilter Twin 2 are the three oscillators, the multimode filters, the delays, the XY Controller, the XLFO, the Envelope Generator, the Envelope Follower and the MIDI source. Each of these modules have parameters that can be changed by both knob movements and modulation. These parameters are called modulation targets. The modules that can send control signals to the modulation targets are called modulation sources. The modulation signal always flows via a modulation slot that allows you to vary the extent of modulation.

FabFilter Twin 2 offers very flexible modulation possibilities which make this plug-in capable of many sound design applications. Ever-changing parameters can make your music become more alive because an exact reoccurrence is very unlikely to happen.

Use the Modulation button at the top to show or hide the entire modulation section, which consists of the following elements:

- **Source selection bar**
  The source selection bar shows a schematic overview of all modulation sources at all times. Simply click on a source button here to scroll the source into view. The highlighted section of the bar shows the currently visible part, and it can be dragged to scroll the sources as well. The top segment of each source button lights up according to the modulation signal it is currently sending.

- **Modulation slots**
  As said before: every modulation source uses a modulation slot to send its signal to the target. Twin 2 always groups all modulation slots above the source that they're connected to. Each slot displays the destination, graphically shows the amount, and you can quickly turn it on or off, or reverse its output.

- **Modulation sources**
  The modulation sources are organized in a horizontally scrolling strip below the source selection bar. There are 5 different kinds of sources available: The XLFO can generate almost any waveform you can imagine and can be synchronized to the host tempo. The Envelope Generator is of the usual ADSR kind and triggered by audio or MIDI. The Envelope Follower will follow the loudness of the incoming audio or side-chain signal. The MIDI source transforms any incoming MIDI data into a modulation signal. And the XY Controller lets you modulate two targets using horizontal and vertical mouse movements.

  To add a modulation source, click the + button in the source selection bar.

  To delete a modulation source, click the remove button X in the top right corner in the source interface. When a source is deleted, modulation slots that use that source will also be deleted automatically.

  **Tip**: You can scroll the modulation source section with the mouse wheel. On Windows, most mouse wheels only work vertically, but you can hold down the Ctrl and Shift keys for horizontal scrolling in that case.

Next: Drag-and-drop modulation slots

See Also
Filters
Overview
Drag-and-drop modulation slots

One of the best features of FabFilter Twin 2 is undoubtedly the ability to set up modulation connections with drag-and-drop. There is no need to search through long drop-down menus containing dozens of sources and targets or to find your way in cluttered and obscure matrix views. This simple method of making modulation connections makes sound designing become fun, easy and, above all: fast. So how does it work?

**Grab a source...**

First, grab the source drag button that you would like to use as a modulation signal, for example XLFO 1. The moment you click on the source drag button, the interface dims and all modulation targets are highlighted.

**... drag it to a target...**

The moment you start dragging, you will see a line from the source drag button to the icon that you are dragging. If you hover the mouse over any of the component buttons it will automatically open. It will then snap to any available modulation target.

**... and drop it.**

Now drop the icon on the highlighted knob of the parameter that you would like to modulate, for example the Master Tune knob. That’s all there is to it!

If you wish, you can also add a slot manually using the small plus button above each modulation source. You can also modulate slot level knobs, which makes incredibly complex modulation setups possible. To sort the slots click the + button in the source selection bar and select Sort Slots from the menu that pops up.

Once a slot has been added, you can edit it:

- Use the Level slider to adjust the amount of modulation. Like with knobs, hold down Shift for fine-tuning; hold down Alt to adjust all slot levels for the same source; Ctrl-click (Windows) or Command-click (macOS) to reset the level to the default value.
- To the left of the Level slider, you can invert the modulation signal with the +/- button.
- When you hover over the slider on the left an on/off button appears. Use this to temporarily disable the slot. On the right a menu is accessible that gives direct access to all available modulation targets.
- To delete the slot, click the Remove button to the right of the Level slider.

Our what-you-use-is-what-you-see interface makes complex programming very easy. Twin 2 uses dynamic slot highlighting to visualize all the sources that modulate a specific target. When a parameter is modulated a small modulation indicator appears:

Click the modulator indicator to highlight all slots that modulate this target. In the source selection bar the sources that modulate the target are also highlighted.

This feature makes programming so much more fun because it’s easy to see what is happening inside a patch. To return to the normal interface click anywhere on the interface background or click the Modulation Indicator again.

When a modulation indicator appears next to a component button or envelope generator it means one or more parameters are modulated. When you click that indicator it will highlight all slots that modulate a target of the component or envelope generator.

**Next:** XLFO

**See Also**
Modulation
What-you-use-is-what-you-see
**XLFO**

The XLFO is like a classic LFO but it can do so much more! It can also be used as a 16 step sequencer with an individual glide parameter for every step. The display shows the waveform that is used by the XLFO. Steps can be freely added or deleted to shape the funkiest of waveforms. But there is more... This XLFO can also be used as arpeggiator! The values can be equally be distributed over 2 octaves, so when connecting it to any pitch parameter, it will function like an arpeggiator. We couldn't make it more funky! (Any suggestions? Please let us know.)

To add an XLFO as a modulation source, click the + button in the [source selection bar](#) and click **New XLFO**.

At the left of the XLFO interface, you find the global parameters that affect the entire waveform:

- **Frequency**
  - The frequency knob sets the time it takes for 1 cycle of the waveform to complete. This knob is a modulation target, so you could let one XLFO modulate the frequency of another XLFO. The XLFO can be synchronized to the tempo of the plug-in host or set to run free. With the options at the top-right corner of the frequency button you can choose the different settings:
    - Free running mode will allow values from 0.0 to 500 Hz, so the minimum cycle length is 0.002 seconds.
    - When using any of the synchronized cycle lengths (16 to 1/64, measured in bars) the frequency knob changes into the **Offset** knob. It now acts like a cycle length multiplier and therefore is capable of changing the cycle length relative to the host tempo, from half to two times the host tempo. Click the dots around the knob to jump to certain predefined offsets for dotted and triplet synchronization. Note: the Offset parameter is not a modulation target, but you can modulate the Phase offset instead.

- **Balance**
  - The outer ring of the frequency knob adjusts the time balance of the first and last halves of the step sequence. For example, when turned to the left, the first half of the wave form is generated more quickly than the last half.

- **MIDI sync**
  - The XLFO can be restarted at any point using MIDI if the MIDI sync option is enabled at the top-right corner of the frequency knob. When activated a note-on MIDI message (e.g. pressing a key) will restart the cycle of the waveform (to the point set by the Phase offset slider).

- **Snap**
  - This function makes it possible to use the XLFO as an arpeggiator. When you enable Snap, a small piano keyboard appears, the range of the XLFO turns into 2 octaves, and steps "snap" to notes on the piano keyboard. Now when you modulate the oscillator detune, master tune, or filter frequency, turn the slot level to maximum, and the total amount of modulation will exactly correspond to 2 octaves. If you modulate a detune knob, it will sound like a classic arpeggiator. With filter frequency parameters, you will hear individual notes if used with high filter peak settings.

- **Glide**
  - The global Glide knob acts like an overall glide offset. The amount of glide determines the point within a step at which the XLFO starts to interpolate to the value of the next step. The global Glide value is added to the glide value for individual steps to arrive at the final glide value for each step. The final glide value is limited between 0 (no interpolation) and 1 (full interpolation). Because the global Glide value can range from -1 to 1 it can completely overrule the individual step glide values at the extreme settings. It is also a modulation target which allows for very cool effects.

- **Phase offset**
  - In the step editor you can see a triangular shape. The vertical line of the shape indicates the beginning of each cycle. You can move this triangular shape, and thus change the beginning of a XLFO cycle. This phase offset is a modulation target, so when the XLFO frequency is set to 0, you can use another modulator to cycle through the different steps.

**Tip:** Like with knobs, you can Ctrl/Command-click on the phase offset slider to reset it.

At the top right of the global settings, the Presets button ![p] provides access to the XLFO [section presets](#). The Remove button ![x] deletes the XLFO source. By default, the XLFO starts with two steps that make a sine wave. You can customize this by overwriting the predefined Default section preset.
Editing Steps

You can shape the waveform of the XLFO in almost any way you want by editing the individual steps.

- Drag a step up or down to **change the value** for the step.
- Click a step to **select** it.
- Hold down Ctrl (Command on Mac) and click a step to **select multiple steps**. Hold down Shift and click a step to **select a consecutive range** of steps.
- Click next to a step to **deselect** all steps.
- Click the + button at the end of all steps to **add** a new step. The new step is added to the right of the selected step, or at the end of all steps.
- Click the - button at the end of all steps to **remove** the selected steps. If no steps are selected, the last step is removed.

If one or more steps are selected, the XLFO expands to show the **step interface** where the parameters for the selected steps can be edited:

- **Random**
  The Random button enables random values for this step. If enabled, the XLFO will use a new random value for the step each time it encounters it. The display also changes to show that the value is chosen at random (see step 3 in the screen shot above).

- **Value**
  The Value knob adjusts the value of step. This is the same as dragging the step up and down, except that with multiple selected steps, the value of all steps is set to the same value. In contrast, when you drag multiple selected steps, the relative distance is kept the same.

- **Curve**
  The Curve button selects the curve that is used to interpolate to the next step when the final glide value is higher than 0: Linear, Sqr, Sqrt and Sine.

- **Glide**
  The Glide knob sets the per-step glide value. This is combined with the global glide value to determine at which point the XLFO starts to interpolate towards the next step.

To start exploring the many sound shaping possibilities start with a XLFO that **modulates** a Filter Frequency knob to make the sound change over time. You’ll be amazed by the many possibilities. Have a look at the presets to see the XLFO in many different setups to get an idea of what it can do for you and start creating your own sequences to funkify your life!

Next: Envelope generator

See Also
Modulation
Drag-and-drop modulation slots
What-you-use-is-what-you-see
**Envelope generator**

The envelope generator (EG) generates an ADSR envelope. The envelope being the way in which the level changes with time and is controlled by the **Attack**, **Decay**, **Sustain** and **Release** parameters. Its function is to modulate some aspect of the instrument’s sound (often its loudness) over time.

Since you need at least one EG to make a sound, you cannot delete the first EG, called **Main EG**. The Main EG differs from the other EGs because it doesn't have trigger, threshold and delay parameters and always has a range from 0 to 1. The Main EG also has a component button counterpart in the top synth section of the interface, enabling you to tweak attack, decay, sustain and release directly without having to open the modulation section.

To add an envelope generator as a modulation source, click the + button in the source selection bar and click **New Envelope Generator**.

The following EG parameters are available:

- **Trigger**
  The EG can be triggered by two different kinds of input: MIDI note events (MIDI) or the signal from the side-chain (Side Chain). When MIDI is selected, the Threshold knob is hidden. Depending on the type and amplitude of the incoming side chain signal you need to adjust the threshold for optimal functioning. Look at the top segment of the source button for the EG to see when it is in the triggered (Attack-Decay-Sustain) state. See also Using the side chain.

- **Delay**
  The time it takes for the attack to start after the key is pressed (or triggered when the side-chain signal exceeds the threshold).

- **Attack**
  The Attack portion of the envelope is the time taken for the amplitude to reach maximum value. Slow attack is commonly part of sounds called pads. But for percussive sounds the attack time should be as short as possible.

- **Decay**
  After the sound has reached its maximum level, it starts to decay until it reaches a level known as the Sustain level at a rate set by the Decay time setting.

- **Sustain**
  This is the level reached after the decay time. The EG will hold this level as long as a key is pressed. Note that this parameter specifies a volume level rather than a time period.

- **Hold**
  Once the key is released, the value will remain at the sustain level for a time set by the hold parameter.

- **Release**
  After the hold time the sound resumes its decay, this time at a new rate determined by the Release setting.

- **Range**
  Normally, the EG works with a range from 0 to 1 (the top option), but you can also choose to change the range so EG outputs 0 at the sustain level. It will attack from a negative value to a positive value, and finally release to a negative value. The EG “centers” around the 0 value, which can be useful for modulation.

**Tips**

- When adjusting the EG control points, you can hold down the Shift key to fine-tune a setting, just
like with regular knobs.

- To let a sustain pedal control the EG, you can hook it up to the Hold setting. The recommended way to do this is via a MIDI source.

At the top right of the EG interface, the Presets button provides access to the EG section presets. The Remove button deletes the envelope generator. You can customize the default EG settings (used when creating a new EG) by overwriting the predefined Default section preset.

Next: Envelope follower

See Also
Modulation
Drag-and-drop modulation slots
What-you-use-is-what-you-see
Envelope follower

The envelope follower modulation source will output an envelope similar to the side-chain signal. The amplitude of the positive peaks of the input signal is measured and the outer shape (= envelope) is the output signal of the modulation source. You can set the Attack and Release parameters to 'smooth out the bumps'.

To add an envelope follower as a modulation source, click the + button in the source selection bar and click New Envelope Follower.

Note: The envelope follower is only useful if the plug-in is set up in the host application to receive a side chain signal. More about this in Using the side-chain.

At the top right of the source interface, the Presets button provides access to the EF section presets. The Remove button deletes the envelope follower. You can customize the default EF settings (used when creating a new EF) by overwriting the predefined Default section preset.

Next: MIDI source

See Also
Modulation
Drag-and-drop modulation slots
What-you-use-is-what-you-see
**MIDI source**

The MIDI source is a powerful modulation source if you want more control using a MIDI keyboard or MIDI control knobs.

To add a MIDI source as a modulation source, click the + button in the source selection bar and click **New MIDI Source**.

![MIDI source](image)

- **MIDI Input**
  Normally the MIDI source lets you use MIDI input such as velocity, pitch bend and modulation wheel to influence any parameter that can be modulated.

- **Controller number**
  When you set the input selection to Controller, it lets you use any MIDI controller as a modulation source.

- **Response curve**
  The response curve can be adjusted to get the desired control over the MIDI source output. For example, when used with velocity as MIDI source the linear, exponential, logarithmic, square, square root or sine curves make great dynamic differences.

Using a MIDI source is different from MIDI Learn because there is no direct control of a knob via MIDI but it uses a modulation slot instead. This way you can add modulation to an already modulated destination. Or you can use the full rotation of a knob while actually modulating a smaller range. This can be a good way to control say, the filter cut-off frequency or EG attack for which you sometimes want to make small changes with great precision.

At the top right of the source interface, the Presets button provides access to the MIDI source section presets. The Remove button deletes the MIDI source. You can customize the default MIDI source settings (used when creating a new MIDI source) by overwriting the predefined **Default** section preset.

**Tips**

- When modulating oscillator master tune or detune with pitch bend, the default slot level value corresponds to +/- one note of modulation (you can reset to the default value by Ctrl/Command-clicking the slot level). The maximum slot level corresponds to +/- one octave.

- To let a sustain pedal control the Main EG, use a MIDI source. Set the input to Controller, and the controller number to 64. Now, drag the source drag button for the MIDI source to the hold control point of the Main EG, and set the slot level to maximum. Of course, you can also set up more sophisticated behavior of the sustain pedal, for example by modulation the release setting instead of hold: the possibilities are endless.

- The VST 3 version of FabFilter Twin 2 doesn't support per-note aftertouch modulation.

---

**Next:** [XY Controller](#)

**See Also**

Modulation

Drag-and-drop modulation slots

What-you-use-is-what-you-see

MIDI learn
XY Controller

The XY Controller makes for more tweaking fun. It's a classic, and we didn't dare to leave it out! It can control two parameters with one mouse movement. When browsing presets don't forget to listen to the sound mangling possibilities provided by these controllers.

To add an XY controller as a modulation source, click the + button in the source selection bar and click **New XY Controller**.

![XY Controller Image]

Because the XY controller has two "outputs", it also has two source drag buttons labeled X and Y. The slots for the XY controller are grouped in two rows, with the X-slots at the top. For example, in the screenshot above, the X axis controls the output panning, while the Y axis controls the level.

The Remove button × deletes the XY Controller.

**Tips**

- To reset the XY Controller to its default position, hold down the **Ctrl** key (Windows) or **Command** key (macOS) and click once.
- When you want to adjust only one parameter on one axis, holding **Shift** will make it easier to do so while keeping the other parameter constant.
- With **MIDI learn**, you can set up a hardware MIDI controller to control the XY controller. So if your MIDI controller has XY-functionality you can directly control Twin 2.

*Next: Polyphony and unison*

*See Also*

Support
Polyphony and unison

FabFilter Twin 2's polyphony and unison settings are located at the bottom of the interface:

As you would expect, you can use FabFilter Twin in either Mono or Poly mode. In Poly mode, the Voices setting determines the number of voices that can be played simultaneously. Depending on the complexity of the current patch, you should set this to a value that your computer can comfortably handle to avoid glitches while playing.

In both modes you can specify the number of unison voices. When using unison, multiple voices will be activated for each key that you play. Those voices will be panned from left to right, and can be slightly detuned relative to each other using the Spread parameter. Using unison will make your patches sound much more stereo and fat. Try it!

Tips

- The mono mode of FabFilter Twin 2 uses last-note priority, so the last key pressed determines the frequency that you hear. When you release a key, the frequency slides back to the second-last key pressed, and so on.

- The Voices setting always sets the maximum number of simultaneous voices. If Unison is higher than 1, more than one voice will be used at a time from the maximum number. For example, if you have Voices set to 16, and Unison to 4, you can play four different keys at a time. Of course, using a high number of voices, unison or not, will cause high CPU usage.

- Believe it or not, but the Unison Spread parameter is a modulation target. You could, for example, increase the spreading gradually while a note is played by modulating it with an envelope generator.

Next: Output controls

See Also

Overview
Output controls

The output controls are located in the bottom-right corner of Twin 2's interface:

![Output controls interface](image)

This is where the output level and panning settings are controlled. The dry (unprocessed) signal and the output of the delay lines have their own level and panning knobs.

From left to right:

- The **Audition** setting (with the small headphones icon) is normally set to Output. You can set it to Side Chain to be able to listen to the incoming side chain signal. See Using the side chain.

- The **Stereo** setting sets the stereo spreading of the output signal. By default, it is a 100% or 'normal stereo', which means that it does not alter the signal. By reducing the setting towards 0%, the signal will become more mono. By increasing it towards 200%, the differences between the left and right channel are enlarged, which makes the sound more stereo.

- The **Out** setting controls the main output volume and panning.

**Notes**

- Beware that making the signal more stereo can cause some undesirable phase cancellation.

- Both the output level/pan and stereo settings are modulation targets. Volume is commonly modulated by the velocity modulation source. The Stereo knob is a global modulation target, meaning that it affects all voices simultaneously. When modulating a global target like Stereo with a per-voice modulation signal such as an envelope generator, the highest signal value of all active voice envelopes is used.

- Modulating them with per-voice sources such as velocity or an envelope generator is possible, but doesn't give perfect results. Instead, modulate the output level in the bottom bar, described above.

- The resize button next to the Out setting allows you to make the interface wider if desired.

Next: MIDI Learn

**See Also**

Polyphony and unison
Delay section
Overview
**MIDI Learn**

Controlling FabFilter Twin 2’s parameters directly with MIDI is very easy using the MIDI Learn feature. With MIDI Learn, you can associate any MIDI controller with any parameter.

Click the **MIDI Learn** button in the bottom bar to enter MIDI Learn mode. The interface dims and the parameters that can be controlled are highlighted. Each parameter has a small text balloon that displays the associated controller number. Now do the following to associate a controller number with a parameter:

1. Touch the control of the desired parameter in the interface that you wish to control. A red square will mark the chosen parameter.
2. Adjust the slider or knob on your MIDI keyboard or MIDI controller that you want to associate with that parameter.

That’s it! The parameter will now be controlled with the MIDI controller. You can now go back to step 1 to associate a different parameter. Note that there is no warning when you associate a different knob with a controller number that is already used. It will just be replaced.

To exit MIDI Learn mode, click the MIDI Learn button again, or click Close at the top of the interface.

Click the small menu drop-down button next to the MIDI Learn button to access the **MIDI Learn menu**:

- **Enable MIDI**
  This globally turns MIDI control of parameters on or off: useful in hosts that automatically send all MIDI events on a track to all effect plug-ins associated with that track as well.

- **Clear**
  This submenu shows all parameter associations and lets you delete individual associations or clear all associations in one step.

- **Revert**
  Reverts to the last saved MIDI mapping (or the state when the plug-in was started).

- **Save**
  Saves the current MIDI mapping so Revert will go back to this state. The current mapping is automatically saved when closing the plug-in.

---

**Next:** [Undo, redo, A/B switch](#)

**See Also**

[Overview](#)
**Undo, redo, A/B switch**

The Undo and Redo buttons at the top of the FabFilter Twin 2 interface enable you to easily undo changes you made to the plug-in. With the A/B feature, you can quickly switch between two different states of the plug-in.

- The **Undo** button at the left will undo the last change. Every change to the plug-in (such as dragging a knob or selecting a new preset) creates a new state in the undo history. The Undo button steps back through the history to restore the previous states of the plug-in.
- The **Redo** button cancels the last undo command. It steps forward through the history until you are back at the most recent plug-in state.
- The **A/B** button switches from A to B and back. Before switching, the current state of the plug-in is saved, so if you click this button twice, you are back at the first state. The button highlights the currently selected state (A or B). In the example above, the A state is active.
- The **Copy** button copies the active state to the inactive state. This marks the current state of the plug-in and allows you to go back to it easily with the A/B button. After clicking Copy, the button disables itself to show that both states are equal, so there is nothing to copy anymore.

**Notes**

- If the plug-in parameters are changed without using the plug-in interface, for example with MIDI or automation, no new undo states are recorded.
- The Undo and Redo buttons will disable themselves if there is nothing to undo or redo.

*Next:* [Tips and tricks](#)

*See Also*

[Overview](#)
Tips & tricks

Fabfilter Twin 2 has been designed to make sound designing fast, easy and fun. Here are some tips and tricks that will further help you to create a good preset and to get just that sound that you are looking for.

- **Drag-and-drop modulation**
  Obviously, the best tip we can give you, is to make use of the drag-and-drop modulation connection method. There is no need to go searching through the drop down menus for sources and targets: just drag a source icon of any modulation source directly to any knob that can be modulated to fill a modulation slot.

- **Section presets**
  The settings for an XLFO, EG, EF, MIDI source, and the oscillators, filters, and delay sections can be saved in section presets, to be re-used for future sound designing. FabFilter Twin 2 comes with some general factory section presets, but we encourage you to save your own frequently used settings. Use the the Presets button in a section to access the presets menu.

- **Knob linking**
  The level/pan knobs of the oscillators and the freq/pan and peak knobs of the filters can be linked. For example, just hold down the Alt key while turning the Filter 1 frequency knob; the Filter 2 frequency knob will change with it, relative to its current position.

- **Using an XLFO as an arpeggiator**
  The XLFO has a Snap setting (looks like a small piano keyboard). If selected, a small piano keyboard appears and the sliders snap to "note" positions. Also, if you modulate a filter frequency, the master tune, or oscillator detune with this XLFO and turn the slot level to maximum, the note positions in the XLFO will correspond with actual notes. So, you can use this to turn the XLFO into an arpeggiator!

- **Modulating an XLFO frequency**
  You can modulate the frequency of an XLFO with any modulation source other than itself. You could, for example, modulate the frequency with an envelope generator, which can be really cool.

- **Take advantage of the XLFO phase offset parameter**
  The XLFO has a phase offset parameter, which is controlled by the large triangular > slider underneath the step sliders. You can also modulate this! In addition, you can set the frequency to zero, so the XLFO just stays at its current position, and use the phase offset to 'sweep' back and forth through the steps. If you modulate the phase offset you can sweep through the steps multiple times (try this with an XY controller and the slot level at maximum).

- **Modulating a modulation slot level**
  FabFilter Twin 2 lets you modulate the levels of other modulation slots. For example: use the first slot to modulate master tune with an XLFO and use the second slot to modulate the first slots level with a slow envelope. This gets you a swelling vibrato. You can nest modulation in this way as deeply as you want.

- **Portamento**
  We have put a lot of effort in creating a very good portamento, because this really gives a magical feel to your play. Even adding just a little bit works great. We have also implemented a unique polyphonic portamento which enables you to play sliding chords. Try it!

- **Inverted keyboard track frequency modulation**
  When you use the keyboard track in a MIDI source to modulate the Master Tune or Osc 2 Detune parameter, with the modulation level set to the maximum, and set the filter frequency correctly with maximum peak, your filter actually becomes an oscillator and you can play notes with it!

- **Reduce CPU usage**
  To minimize CPU usage, you can disable filters, oscillators and the entire delay section if you are not using it. Keeping Sync at 1 will minimize CPU usage for that oscillator. See also Polyphony and unison.

Next: Stand-alone (Windows)

See Also
Overview
Knobs
Stand-alone (Windows)

Although FabFilter Twin 2 is often more useful as a VST, Audio Units or AAX plug-in because you can combine it with other instruments, you can also run it as a stand-alone application in Windows. To start the stand-alone version, click Start, Programs, and then click FabFilter Twin 2.

Note: On 64-bit Windows, you need to install the 32-bit version of Twin 2 as well to be able to use the stand-alone version. It is not included in the 64-bit installer.

The Windows stand-alone version looks just like the plugin, but it adds a small Options button next to the Preset button to configure the input and output settings. Click it to bring up the Options dialog.

- **Driver Type**
  The stand-alone version can use either ASIO or DirectX drivers, when you select an ASIO driver, an options button will appear. The driver-specific options dialog will let you specify buffer size settings.

- **Buffer Size**
  Selects the size of the playback buffer in samples. Smaller buffers give less latency and a faster response, but they can also cause audible clicks and other playback problems. You should select the smallest buffer size that still works reliably.

- **Sample Rate**
  Selects the desired sample rate in Hz. Some sample rates may not be supported by your sound card, in which case no audio will be played.

- **Midi In Port**
  Selects the external MIDI input port that your MIDI keyboard is attached to.

- **Output Device**
  Selects the sound card that will be used for playback. DirectX and ASIO sound cards are supported.

All changes will take effect immediately, so you can try different settings before closing the dialog. Click OK to make your changes permanent and close the dialog.

Next: Loading presets
See Also
Support
Overview
Loading presets

The included factory presets give a great overview of what you can do with FabFilter Twin 2. You can either use the presets as they are, or tweak them further to create your own unique sounds.

- To load a preset, click the preset button. The presets menu will appear with all available presets. Click a menu item to load that preset. The currently selected preset is highlighted with check marks.
- To explore the presets one by one, click on the little arrow buttons to the left and right of the main preset button. This will load the previous or next preset in the menu.

The preset button shows the name of the current preset. If you have changed the preset by adjusting one or more parameters, the name is dimmed to indicate that this is not the original preset anymore.

Tips

- The Default Sound preset is loaded automatically when FabFilter Twin 2 is started. To change the default settings, simply overwrite this preset by clicking Options > Save As Default in the presets menu.
- To browse presets without delay use the "0 Lock" setting for the Delay Enabled switch below the Wet level/pan knob to make sure a delay setting is loaded but not used. See Delay section.
- When you find an XY Controller used in a preset we suggest you try what it does to the sound!
- To open a preset outside the presets folder, click Options > Open Other Preset. This might be useful if someone sends you a preset by e-mail, for example.
- If somehow the factory presets are lost or not installed properly, click Options > Restore Factory Presets in the preset menu to restore them.

MIDI Program Change and Bank Select

Loading a presets can also be done via MIDI, using Bank Select and Program Change messages. Click Options > Enable MIDI Program Changes in the preset menu to enable or disable this feature. When enabled, the corresponding bank/program numbers are shown in front of the preset name (for example: (2/65) My Preset). This means that you can load that preset by first sending a Bank Select message to select bank 2 and then sending a Program Change message to select program 65.

Important: All the presets in your preset folder are numbered automatically, starting with bank 0 and program 0. This way, you are able to access any of the presets via MIDI. However, this also means that when you add new presets to the menu, bank/program numbers of other presets might change. Be aware of this when recording program changes in a session!

Compatibility with Twin 1

All presets created with Twin 1 can be loaded in Twin 2. If Twin 1 is also installed on your computer, your Twin 1 presets will be accessible via the V1 Preset Folder submenu in the preset menu. The factory presets for Twin 1 are also included in the Twin 2 factory presets, so you only need to use the V1 Preset Folder submenu to access presets you might have created yourself.

You can read more about compatibility between Twin 1 and Twin 2 in Upgrading to Twin 2. Please take some time to read it if you are planning to replace Twin 1 instances with Twin 2 instances in your songs.

Next: Saving presets

See Also
Overview
Quick Start
Saving presets

You can easily extend the included presets with new settings to build your own library of presets for FabFilter Twin 2 that you can reuse in various projects. This is also a good way to copy settings across multiple instances of FabFilter Twin 2 in a session.

To save the current setting as a preset, click the preset button, and then click Save As. A standard Save dialog will appear. Type a name for the new preset and click Save to finish.

In the Save dialog, you can also rename and delete existing presets and create a new folder to store presets in. New folders will show up as new categories in the preset menu. (On macOS, this should be done with the Finder.)

See How presets are stored to determine the preset folder location and learn more about factory presets.

Next: Section presets

See Also
Loading presets
Using FabFilter Twin 2
Section presets

You can save your own unique settings for different components of the plug-in using section presets. This way you can reuse certain common settings to customize Twin to your own needs. To load and save section presets, click the Presets button in a section. This will display a presets menu for that section.

FabFilter Twin 2 comes with a basic selection of section presets, but we encourage you to save your own presets to build a custom library of sound building blocks.

Supported sections are:

- The combined oscillator section.
- The combined filter section, including routing
- The combined delay section, including routing and delay filters
- XLFO
- Envelope generator
- Envelope follower
- MIDI source

When you add a new modulation source, it loads its Default section preset. You can customize the initial settings by just overwriting that preset using the Save dialog.

Section presets are stored in the Application Data folder (Windows) or Application Support folder (macOS) for the current user. For example, the full path to the section presets on Windows 10 is C:\Users\<User>\AppData\Roaming\FabFilter\Twin 2\Component Presets (note that this folder is hidden by default). You cannot change the section preset paths.

Next: How presets are stored

See Also
- Loading presets
- Overview
How presets are stored

Presets for FabFilter Twin 2 are stored in separate files with the .ffp extension (for FabFilter Preset). All presets reside in subfolders in the main preset folder. The subfolders will show up as separate categories in the preset menu. You can also further divide the subfolders into categories.

You can manage the preset files just like other files on your computer. The easiest way to do this is in the Save dialog that appears if you are saving a preset. The preset menu will automatically reload itself with the changes when the dialog is closed.

Furthermore it is very easy to share your newly created presets with other users since FabFilter presets use the same file format on both Windows and macOS.

The default location of the main preset folder is Documents/FabFilter/Presets/Twin 2 on both Windows and macOS. To change this location, first copy all presets to the desired new location, and then click Options > Change Preset Folder in the preset menu and select the new folder.

Note: previously on macOS, presets were stored in ~/Library/Audio/Presets/FabFilter/FabFilter Twin 2. To determine the current location of the presets folder, click Options > Change Preset Folder in the preset menu.

Restoring factory presets

If you have accidentally lost the factory presets, you can easily restore them by clicking Options > Restore Factory Presets in the preset menu. This will install all factory presets again.

Next: Purchasing FabFilter Twin 2
See Also
Saving presets
Overview
Purchasing FabFilter Twin 2

Once you have downloaded and installed the evaluation copy of FabFilter Twin 2, you may evaluate it during 30 days. Every time you start the plug-in, you will see the following dialog:

![FabFilter Twin 2 Evaluation dialog](image)

While there are still days left, you can click **Evaluate** to start working with the plugin. If you want to keep using FabFilter Twin 2 after the evaluation period, you must buy a copy in the online FabFilter Shop by clicking the **Buy Now** button in the evaluation dialog.

- [Go to the FabFilter Shop and purchase FabFilter Twin 2 now](#)

We accept a wide range of payment methods, like credit cards, PayPal, wire transfer and iDeal. The FabFilter Shop uses secure connections and encryption: therefore your personal information is completely safe.

Within a few minutes after you have purchased your copy, you will receive an email containing your personal license key. You use this license key to turn the evaluation copy into a fully registered version without the evaluation dialog and the 30-day trial restriction. In addition, we will automatically create a **FabFilter account** for you (if you don't have one already). Here, you can access all your license keys at any time.

**Note:** If the evaluation period has expired but you didn't have the chance to properly evaluate the plug-in, you can request a new evaluation period by contacting us at info@fabfilter.com.

Next: [Entering your license key](#)

See Also
- Support
- License agreement
Entering your license key

After you have purchased FabFilter Twin 2 in the online FabFilter Shop, you will immediately receive an e-mail containing your personal license key. This license key will turn the evaluation version into a fully registered plug-in.

- Start FabFilter Twin 2 and click Enter License in the evaluation dialog, or click Enter License on the Help menu if the plug-in is already running.
- Copy the license information from the email you have received and paste it into the text field. Make sure that you are copying the entire license key including the Product and Licensee lines! If you are not sure what text to copy, just copy and paste the whole e-mail.

After you have entered your license information, you will need to restart the plug-in host, so make sure you save your settings if needed. From now on, you will be able to use FabFilter Twin 2 for an unlimited period of time with full support via email.

Tips
- After your purchase, you can always retrieve your license key again by logging into your personal FabFilter account. Here you can also keep track of all your orders and take advantage of great discounts when buying other FabFilter plug-ins.
- To deauthorize your license key and remove it from the computer, click Deauthorize on the Help menu. If you temporarily needed to install your license on another computer, or if you have transferred your license to someone else, this is the way to deinstall your personal license key safely.

Next: Support

See Also
Purchasing FabFilter Twin 2
Support
License agreement
Support

If you need help with problems or questions, and the help file does not provide an answer, please visit the support pages on our web site.

- Go to FabFilter Support

From here, you have direct access to the customer support forum, very useful tutorial videos for all FabFilter plug-ins, online and PDF versions of all our help files, and a section with extra downloads (such as presets, controller templates, older plug-in versions).

For sales-related questions and technical support, you can also contact FabFilter directly at info@fabfilter.com.

Reporting a bug

If you have encountered a bug in FabFilter Twin 2, first of all make sure that you are using the latest version of the plug-in, which you can find at www.fabfilter.com/download. You can easily check the version of FabFilter Twin 2 that you are using by clicking Help > About in the plug-in interface. If the bug is still present in the latest version, please send us an e-mail at info@fabfilter.com and include as much technical information as possible: operation system and version, host software and version, steps to reproduce the bug, etc. Thanks in advance!

Next: Upgrading to Twin 2

See Also
Overview
About FabFilter
Upgrading to Twin 2

Upgrading from Twin 1 to Twin 2 is safe and easy: installing Twin 2 will not replace or delete the previous Twin 1 plug-in. Both versions will co-exist and can both be used at the same time. This ensures that you can open old songs that use Twin 1 without problems!

Twin 1 presets

All presets created with Twin 1 can be loaded in Twin 2. If you upgraded from Twin 1 to the new version, your original Twin 1 presets will be accessible via the V1 Preset Folder item in the preset menu. See also Loading presets.

Replacing a Twin 1 instance by Twin 2

If you are working on a song and want to replace a Twin 1 instance with the new Twin 2, we advise you to do the following:

- First, save the current setting of the Twin 1 instance as a FabFilter preset in the Twin 1 preset folder.
- Then, remove the Twin 1 instance and add Twin 2 in its place.
- Finally, load the V1 preset that you just created into Twin 2 via the V1 Preset Folder submenu in the preset menu.

Automation

Because the feature set of Twin 2 has changed drastically, any automation data that has been written by a Twin 1 instance cannot be read correctly by Twin 2.

See Also

Overview
Support
Manual installation

When installing FabFilter Twin 2, the installation program will try to copy the plug-in into the appropriate plug-ins folders, and in most cases your host will recognize FabFilter Twin 2 automatically. Otherwise, please follow these instructions:

Windows

On Windows, most hosts have their own VST plug-ins folder. So if you are using Windows and your host does not recognize FabFilter Twin 2, you need to locate the proper plug-ins folder for your host first (it is usually shown in the Preferences or similar dialog). Then, copy the file FabFilter Twin 2.dll from C:\Program Files\FabFilter\Twin 2 (or C:\Program Files (x86)\FabFilter\Twin 2 if you are using a 32-bit host on 64-bit Windows) to the plug-ins folder that you have found and restart the host so it can reload all its plug-ins. For the AAX version of Twin 2, copy the FabFilter Twin 2.aaxplugin folder to the common Pro Tools AAX plug-in folder on your computer.

You can simply uninstall plug-ins or bundles via the Control Panel.

macOS

On macOS, plug-ins are installed in the standard plug-in folders in the system Library folder. These are the only possible correct locations:

- Audio Units: /Library/Audio/Plug-Ins/Components
- VST/VST3: /Library/Audio/Plug-Ins/VST and /Library/Audio/Plug-Ins/VST3
- AAX: /Library/Application Support/Avid/Audio/Plug-Ins

Note: AU and VST/VST3 plug-ins may also be placed in the user’s Library folders under /Users/<username>/Library/Audio/Plug-Ins.

To uninstall the plug-ins from your Mac, you can just delete the specific FabFilter plug-in files at the above locations. Finally, if you really want to delete all data written by our plug-ins, you can remove the following folders/files from the user Library folder as well:

- /Users/<username>/Library/Audio/Presets/FabFilter/FabFilter Twin 2
- /Users/<username>/Library/Application Support/FabFilter/Twin 2
- /Users/<username>/Library/Preferences/com.fabfilter.Twin.2.plist

Note: Since OS X 10.7 (Lion), the system and user Library folders are marked as hidden by default. To make them visible again in Finder, open Terminal (found in /Applications/Utilities) and enter the following commands:

    chflags nohidden /Library
    chflags nohidden ~/Library

If you still have problems, contact FabFilter Support.

Next: Using the side chain
See Also
Quick start
Support
Using the side chain

FabFilter Twin 2 offers the possibility of feeding an external signal to its side chain, which can be used to trigger Envelope Generators around Envelope Followers. Feeding a signal to a plug-in’s side-chain inputs works slightly different in various hosts. This topic describes the procedure for some of the most popular hosts around: Pro Tools, Studio One, Ableton Live, Logic Pro and Cubase.

To explain how it works, we use a scenario with two tracks. The first one contains Twin 2, which we'll call the *main track* from now. The second track contains the audio that we want to route to Twin 2’s external side-chain input and use as trigger signal. We’ll call this track the *side chain track*.

After setting up everything according to the instructions below for your host, any envelope generators or envelope followers that are set to trigger on the external side chain, will now respond to the side chain signal. You can check whether everything is routed correctly: play the audio, open an EG of EF interface and confirm it's set to trigger to the external side-chain. Then use the Audition button to listen to the side-chain signal.

**Pro Tools**
- Open Pro Tools and start a new empty session.
- Create and instrument track and an audio track. Add and audio file to the audio track (the side chain track).
- Open the Mix window to display the tracks with their Insert slots and Sends slots.
- In the first 'Sends' slot of the side chain track, choose 'Bus 1'. The track view for Bus 1 will open: set its level slider to 0.0 dB so the bus actually produces audio!
- In the first 'Inserts' slot of the main track, choose Instrument > FabFilter Twin 2.
- Open Twin 2’s interface and set up an envelope generator or envelope follower, triggered by the external side chain signal.
- Now, in the 'Key Input' menu of the plug-in interface (just above the FabFilter logo), choose bus > Bus 1 instead of the default 'no key input'. Now, the audio from the side chain track is routed to Twin 2’s external side chain input via Bus 1.

**Studio One**
- Open Studio One and choose 'Create a new song'.
- Create and instrument track and an audio track (via Track > Add Tracks...). Add and audio file to the audio track (the side chain track).
- Access the mix window via "Mix" in Studio One’s bottom right corner.
- Insert FabFilter Twin 2 on your main track via the ‘+’ button next to the Insert tab.
- Open Twin 2’s interface and set up an envelope generator or envelope follower, triggered by the external side chain signal.
- On the side chain track, select Sends > Sidechains > FabFilter Twin 2.

**Ableton Live**
- Open Ableton Live and start with an empty arrangement. We’ll use Track 1 as the side chain track and Track 2 (a MIDI track) as the main track.
- From the folder menu's on at the left top of Ableton Live's interface, drag an audio clip to the first empty slots of Track 1.
- From the VST (or Audio Units) plug-in menu, also at the left top of Ableton Live's interface, drag FabFilter Twin 2 onto Track 2, the main track.
- In the small device interface for Twin 2 in the bottom Effects section, choose 'Track 1' from the 'Sidechain' drop down menu.
- Open Twin 2’s interface and set up an envelope generator or envelope follower, triggered by the external side chain signal.
- **Note**: In earlier versions of Ableton Live (< 10.1), setting up sidechaining worked differently, which is described [here](#).

**Logic Pro**
- Open Logic Pro and create a new empty project via File > New...
- Create and instrument track and an audio track. Add and audio file to the audio track (the side chain track).
- Select the main track and add Twin 2 in the instrument slot.
Open Twin 2's interface and set up an envelope generator or envelope follower, triggered by the external side chain signal.

In the right top corner of the plug-in interface header, in the 'Side Chain' menu, choose the side chain track. Now, the signal from the side chain track is sent to FabFilter Twin 2's external side-chain input.

**Cubase**

- Open Cubase and create a new empty project.
- Create an instrument track and an audio track. Add an audio file to the audio track (the side chain track).
- Open the Mixer. In the main track, click on an empty insert slot and select the VST 3 version of FabFilter Twin 2 in the Instrument menu (note the VST 3 icon which looks like ///).
- Open Twin 2's interface and set up an envelope generator or envelope follower, triggered by the external side chain signal.
- In the plug-in header, click on the Activate Side-Chain button (right of the R/W buttons) to enable the external side chain in Cubase.
- At the top of the Mixer, set the output for the side chain track to the side-chain input of FabFilter Twin 2.

**Next: MIDI CC table**

**See Also**

Quick start
Support
MIDI controller messages

All of FabFilter Twin 2's parameters can easily be controlled using MIDI. Here is a list of the default MIDI controller numbers that correspond to the parameters. You can use these controller numbers to control each parameter with the sliders on your MIDI keyboard or MIDI controller.

Not all parameters are linked to a CC number by default. Using the MIDI Learn feature, you can change and add CC number associations any way you like.

General
7 - volume
5 - portamento
103 - polyphony

Oscillators
22 - detune 1
20 - scale 1
21 - waveform 1
23 - pulse width 1
28 - detune 2
78 - scale 2
87 - waveform 2
29 - pulse width 2

Filters
74 - frequency 1
71 - peak 1
26 - frequency 2
27 - peak 2

Main EG
73 - attack
75 - decay
79 - sustain
72 - release

XLFO 1
76 - frequency
25 - balance
89 - glide

Notes
- You can also consider using a MIDI source, which provides a different way to use controller change messages.
- Unlike in Twin 1, CC 64 (sustain pedal) is not connected to EG Main Hold by default, because it gives much more flexibility to use a MIDI source instead.

Next: License agreement
See Also
Support
FabFilter Software License Agreement

This license agreement concerns and describes your rights and the conditions upon which you may use the FabFilter software you selected. We advise you to read this entire agreement. By accepting this agreement or by using FabFilter software, you agree to all of these terms. If you do not accept and comply with these terms, you may not use the FabFilter software or its features.

Applicability

This license agreement applies to all the FabFilter software, plug-ins and programs you may use during the Evaluation period, and/or thereafter subject to an acquired license key to certain FabFilter software of any version, including any and all upgrades, supplements or services, unless other terms come with such versions, upgrades or supplements.

Licenses

The software will be licensed to the Customer, not sold. With the FabFilter license key, you will be granted after full payment the right in perpetuity (meaning that the license agreement shall not automatically expire) to install, run and use the software concerned under certain conditions. These conditions vary subject to the license you acquired. FabFilter distinguishes the following licenses:

- A **Personal License** is a named license to the software concerned, granting access to the software on an unlimited number of Devices, as long the license is used by the designated person who acquired the FabFilter license key. Usage of the Personal license by someone else but the designated licensee is an infringement of the rights of FabFilter. The Customer should at all times protect its license key from theft and/or abuse.

- A **Site License** is a non-personal license to the FabFilter software concerned, acquired on the name of an institution or entity, who is the licensee. A Site License will grant access to the FabFilter software on a certain maximum number of designated Devices, as specified in the license key itself (e.g. "20 seats"). If the Site License is used on computers/servers for any form of automated processing, the licensee may not make any plug-in controls/parameters of the FabFilter software available to the end users of the FabFilter software, i.e. only "black box" processing is allowed.

These FabFilter licenses, whether a Personal or Site License, will give you access to certain FabFilter software of the specified major version. The license will include all future minor updates to the software (e.g. version 2.19 to version 2.20), which typically include bug fixes or small new features. The license will exclude any future new major versions of the products (e.g. version 1.x to version 2.x). To allow yourself access to such new major version of the software, a new FabFilter license to such major version must be acquired.

All FabFilter licenses, both Personal or Site License, give the Customer or end user the right to install and use the FabFilter software to the extent it has been developed and under the conditions herein. Any rights not explicitly granted to you, the Customer, remain with FabFilter, including but not limited to the right to alter, reverse engineer, reverse compile, take apart, or disassemble the FabFilter software or any of the files in the distribution.

A Bundle License is Personal or Site License for multiple FabFilter software products, which gives the Customer or end user the right to install and use the specific software products that the bundle (e.g. Total Bundle) contains at the moment of purchasing the Bundle License. Any software products or new major software versions added to the bundle after that date cannot be claimed as part of the prior acquired Bundle License. A Bundle License (if not Educational or NFR) can only be transferred as a whole, using a License Transfer.

An Upgrade License is a Personal or Site License for a new major version of FabFilter software. You may only use an Upgrade License if you have a license for the previous major version of the same FabFilter software.

Educational (EDU) and NFR licenses

A Personal or Site License can be marked as EDU (Educational) or NFR (Not For Resale), meaning the following:

- A Personal or Site License marked as Educational License is equal to the respective Personal or Site License, with the only exception that the Educational License may not be transferred to a third party.

- A Personal or Site License marked as NFR ("Not For Resale"), is typically intended for journalists that wish to review the FabFilter software. A License marked as NFR is equal to the respective Personal or Site License, with the only exception that the NFR License may not be transferred to a third party.

Duration and Evaluation

As specified in the specific terms per license, all licenses will be granted for perpetuity (meaning that the license agreement shall not automatically expire), as long as all conditions herein are respected.
The Evaluation period is a period of thirty (30) days commencing on the first day of using the software concerned and automatically expiring 30 days thereafter. After the Evaluation period has expired and no FabFilter license key has been acquired, the software will stop working and should be removed from your computer.

In addition to any and all such possibilities that FabFilter may have in accordance with the law, FabFilter may terminate without prior notice or warning in case of abuse of the FabFilter software as well as in case of (personal) bankruptcy.

**Support**

FabFilter shall give its reasonable commercial efforts to service any major version of any FabFilter software including email support. FabFilter is entitled to terminate support for any major version of any FabFilter software at any time at its sole discretion.

**License Transfer**

A Personal or Site License (not Educational or NFR) may be transferred to a third party. You will have to buy a License Transfer to activate the "transfer"-option in your FabFilter account. After this option has been activated you will be able to transfer your license to any third party.

**Third Party Software**

VST is a trademark of Steinberg Media Technologies GmbH. RTAS and AAX are trademarks of Avid Technology, inc. Audio Units is a trademark of Apple Computer, inc.

**Applicable Law**

This license agreement is governed by Dutch law. The courts of Amsterdam are authorized courts to rule on any dispute that may arise from this license agreement.

**Disclaimer**

TO THE MAXIMUM EXTENT PERMITTED BY LAW, FABFILTER, FREDERIK SLIJKERMAN AND FLORIS KLINKERT, AUTHORS OF THIS FABFILTER PRODUCT, SPECIFICALLY DISCLAIM ALL WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. FABFILTER, FREDERIK SLIJKERMAN AND FLORIS KLINKERT, DO NOT WARRANT THAT THE SOFTWARE WILL MEET YOUR REQUIREMENTS OR THAT THE SOFTWARE WILL OPERATE ERROR-FREE OR UNINTERRUPTED. TO THE MAXIMUM EXTENT PERMITTED BY LAW, FABFILTER, FREDERIK SLIJKERMAN AND FLORIS KLINKERT, SHALL NOT BE LIABLE FOR ANY DAMAGE A FABFILTER PRODUCT MAY CAUSE OR DAMAGES THAT MAY ARISE OUT OF THE USE OF A FABFILTER PRODUCT OR INABILITY TO USE A FABFILTER PRODUCT, INCLUDING BUT NOT LIMITED TO SPECIAL, INCIDENTAL, CONSEQUENTIAL OR OTHER DAMAGES. IN NO EVENT FABFILTER, FREDERIK SLIJKERMAN OR FLORIS KLINKERT WILL BE LIABLE FOR AN AMOUNT IN EXCESS OF TWO HUNDRED FIFTY EUROS (€ 250,00).

Next: Acknowledgements

See Also

Purchase FabFilter Twin 2
Support
Acknowledgements

FabFilter Twin comes with a huge library of over 1500 factory presets. These were created by the following sound designers:

- Frank Genus, Pro-Sounds (PS)
- Daniel Maurer (DJM or DM)
- bManic (BM)
- Ouroboros (O)
- Stephan Müsch (SM)
- Teksonik (TEK)
- Frank Neumann, Particular Sounds (FN)
- Ingo Nasse, Particular Sounds (IN)
- Marco Raaphorst (MR)
- Joel Zimmerman (JZ)
- Jaime Newman (JN)
- Rory Dow (RD)
- Scott Gilfix (SDG)
- Floris Klinkert, FabFilter (FL)
- Frederik Slijkerman, FabFilter (FS)

Visit the FabFilter sound designers page to read more about each sound designer.

Thanks to the beta testing team for their relentless support, great ideas and continuous feature requests! ;-)

Credits go to Gijs van Klooster for writing this help file. You can visit Gijs' web site at www.redhouse.nl.

Next: About FabFilter

See Also
- Purchase FabFilter Twin 2
- Support
About FabFilter

Beautiful sound. Fantastic workflow. These are the foundations of FabFilter. We create powerful audio plug-ins with superb sound quality and innovative interfaces.

A unique perspective

At FabFilter, we make the best possible tools for music production and audio processing. To achieve this, we continually rethink and challenge industry standards: we've never been afraid of reinventing the wheel. Considering every little detail, we tune our algorithms and interfaces until they sound perfect, look amazing and feel great to work with.

It's the sound that counts

Above everything else, you need superb sound quality. That's why we put a lot of effort into developing unique audio processing algorithms, ranging from our famous resonating filters to transparent high-end EQ and dynamics processing.

Innovative interfaces, great design

Every FabFilter plug-in has an easy-to-use, well-designed interface aimed at providing unsurpassed workflow. Our plug-ins focus on the task you're performing at that specific moment: they expose the features you need, when you need them. And because of our special attention to design, you'll be delighted every time you open a FabFilter plug-in.

Don't take our word for it

We always set the highest standard for sound quality, usability and design to make truly great products that raise the bar on what audio software can do. That's why we're very happy with the praise we've received from users and press alike:

"In the decade since the release of its first plug-in, One, FabFilter has made an indelible mark on the music production landscape." — Computer Music magazine

"While many other software developers are busy trying to model hardware, FabFilter is leaving them in the dust by being visionaries and reaching into the future. FabFilter stuff is just on another level." — Jeff Sanders

"FabFilter has an enviable reputation for making easy-to-use, powerful tools." — Music Tech magazine

FabFilter was founded in 2002 by Frederik Slijkerman and Floris Klinkert, and is based in Amsterdam, The Netherlands.

See Also

Support
FabFilter web site